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STARTING FROM SCRATCH: Building a Transcript Template in Word 2010

By Kristen Shankleton

GOAL

To create a basic template in Word 2010 so as
to ensure that one's transcripts are prepared in
strict accordance to the criteria as set forth in
the Transcript Format section of the Manual For
Court Reporters and Recorders.

It is frequently discussed that we are to produce
transcripts according to the standards set forth
in the Manual For Court Reporters and
Recorders. In fact, it is our adherence to these
standards which set us and our work product
apart from lay transcriptionists. While employed
at Modern Court Reporting & Video as a CER
for the last thirteen years, | have spent much
time trying to figure out how to work smarter not
harder when preparing transcripts. However, |
have had my share of extremely frustrating
moments not knowing how to fix one simple
thing in Word. It seems at times that night and
day pass before | eventually figure it out. | have
also heard individuals mention at our
conferences that people do not have a template
or do not know how to create many of the
elements of a template for a court transcript in
Word. Our Education Chair, Diane Pelts, asked
me to create something that might be helpful for
workshop attendees preparing for the CER
exam. | am passing the same information along
to you in hopes that it will assist you in your
transcript preparation process so that it may be
done efficiently and with ease, while
simultaneously increasing your familiarity in
navigating the Word program.

| have separated the template-building process
into two sections: Section | discusses setting up
the correct transcript format to prepare for
typing; Section Il deals how to set spacing and
margins correctly, especially for colloquy, Q and
A, and parentheticals. PLEASE NOTE! | have
not included every specific aspect of transcript
preparation, such as font, font size, or the
specific elements that go on a title page, table of
contents, or certification page, et cetera.
Please see your Manual for those specific
elements.

| am using Word 2010 to assist you in setting up
your template. If you cannot find something
according to what | have listed, think about what
it is that you're attempting to do: "Am | inserting
something? Am | changing something on the
actual layout of my page?" Those words can
help you identify which tab the information you're
looking for may be under in your version.

SECTION I: TRANSCRIPT FORMAT

Content Covered in Section I:

«» Saving template vs. actual transcript

« Setting defaults

« Vertical line

« Line numbering

« Page numbering

» Remove AutoCorrect and pre-programmed
features

« Spacing

While building your template, | suggest keeping
the cursor at the very first space on the
document; no returns, spaces, nothing until
Section | is complete, as returns can affect
correct line spacing, line numbering, et cetera
until the template is complete. Just use
backspace or the delete button to be sure you're
at the first position on the document.

1. Begin

Open a blank document. Click File->Save As.
Save it as Court Template. You will use this as
your template in the future. HOWEVER, when
you are preparing an actual transcript, one of
the first things you should do is open this court
template, and click Save As, and save your
document with a name which you are
designating your transcript (Ex: P.v.Smith
7-16-12). Otherwise, if you do not, and you just
click SAVE on your template, you will eventually
learn you have to go back and remove
everything for that particular transcript in order to
have a template again.

2. View

Make sure you can see your ruler bar at the top
of your document and down the left side of your
document. It literally looks like a ruler! If you
cannot see this, go to the View tab and click on
Ruler. Also, make sure you are working in Print
Layout view. It is also under the View tab.
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3. Vertical Lines

Click on Page Layout tab. Click on Page
Border tab. Under Style, click the first listed,
thin line in the box that is offered. Under
Preview, click the left and right side of the
diagram shown, as we are inserting vertical
lines. Under that box you will see Apply To,
and leave it at Whole Document. Under there
you will see Options. Click on it. You'll see a
box that says Measure From. Under that click
From Text. Otherwise, you will have issues with
this line when you need to indent quotations and
other things which will come up in the body of
your text. Click Okay. You should see these
lines. Some people like to type with the white
space on/off. White space is the area at the
bottom of your page that makes it look like an
actual sheet of paper. If you type with your
white space on or open, you will probably see a
thicker horizontal grey line between pages and
you will also see your page number. If you want
that space to go away, you can do so by placing
your cursor over that line until two arrows
appear pointing to each other, one pointing up
and one pointing down. Then just click. You will
notice that your vertical line goes away as well.
However, it will still be there when you print.
Speaking of page numbers....

4. Page Number

Click on Insert tab. Click on little triangle next to
Page Number. Click on Bottom, Center as
that is where our page numbers go.

5. Margins

Click on Page Layout tab. Under that, click
Page Setup (little arrow indicates there's more
to see). Click on Margins tab. You will see they
are indicated in inches. Insert our required
margin settings: Top = 1, Bottom = 1.6, Left =
1.38, Right = .38. If you do not have to have
specific margins for other documents on your
computer, | would recommend clicking Set As
Default; that way you know your margins will
always be correct. Since we're here, go ahead
and make sure your paper is Orientation is
Portrait, not landscape. Just a note: setting
something as a default means every time you
pull up any blank document to try and type, it will
DEFAULT to what you have set it to always
come up as. Therefore, if you set these margins

as your computer's default, these margins will
always be present for any new document you
want to create. If you have a document you want
the margins to be 1" all the way around, you can
go in and change them the same way we just did.

6. Font

Click on Home tab. You'll see Font lightly
written with another arrow pointing downward to
the right. Click on that. Again, that little arrow
means there's more options under this tab.
Under Font, click an acceptable font per our
guidelines. | prefer Courier New. Font Style,
click regular. Font Size, click 12. Again, |
HIGHLY recommend setting this as your default,
as you will see that option in the lower left-hand
corner of this screen. Again, this would make it
so your font, font size, and style will always be
what you just set it for when you type documents
in the future from something other than this
template.

7. Line Spacing For Title Page and Table of
Contents Page

Now we will set spacing for these pages ONLY at
this point. Click on Home tab. Next to
Paragraph, again lightly written as Font was in
Step 6, click the right-down pointing arrow for
more options. Click on Index and Spacing tab.
Go to Spacing section. Where you see Before
and After, those numbers should be 0 (zero) pt.
Line Spacing should be set at Single. This will
change later on the actual transcript pages. Click
Okay, not Default.

8. Removing Automatic Settings That Come
With Word

Many word processing programs come
pre-programmed with some things which the
designers believe would assist us. However,
some of these settings interfere with the
standards we are to keep in producing
transcripts.

Remove Widow/Orphan - Click on Home tab.
Next to Paragraph, again lightly written as Font
was in Step 6, click the right-down pointing arrow
for more options. This time click on Lines and
Page Breaks. Uncheck ALL of the boxes.
Again, | highly recommend clicking Set as
Default.
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SECTION II: MARGINS/SPACING FOR COLLOQUY,
Q& A, and PARENTHETICALS

Content Covered in Section II:

Margin/Spacing requirements for Colloquy, Q and A,
and Parentheticals

Understanding the Ruler Bar

Setting correct margins

1. Review of the Manual

There are certain portions of a transcript which have
specific spacing designations for the left and right
margins. The following information is taken from
Manual For Court Reporters and Recorders, Section
5, Transcript Format, pages 4-5.

1) Left-hand margin

a) Q and A begins at the left-hand margin. There are
5 spaces from the margin to the text; that is, the text
begins on the 6th space. A carryover line begins 5
spaces from the left-hand margin; that is, it begins on
the 6th space.

b) Colloquy begins 15 spaces from the left-hand
margin; that is, it begins on the 16th space. A
carry-over line begins 5 spaces from the left-hand
margin; that is, it begins on the 6th space.

¢) Quoted material and readback begins 15 spaces
from the left-hand margin and ends 5 spaces in from
the right-hand margin. A carry-over line begins 10
spaces from the left-hand margin. A new paragraph
of quoted material begins 15 spaces from the
left-hand margin.

d) Parenthetical material begins 15 spaces from the
left-hand margin. A carry-over line begins 15 spaces
from the left-hand margin.

e) New paragraphs begin 15 spaces from the
left-hand margin.

2) The right-hand margin is observed in every
instance except for quoted materials and readbacks.

2. Ruler Bar Review

The ruler bar, as previously mentioned, looks like a
ruler across the top of your transcript and down the
left side of it.

With your cursor on the first line of your transcript, up at
the top of your document, look at your Ruler Bar. You
will see a grey space on the left with numbers and white
space on the right with numbers, separated by what
looks like two little triangles pointing toward each other,
one with a rectangle below it. THESE TWO
TRIANGLES ARE INDICATING WHERE YOUR LEFT
MARGIN IS SET (as set in STEP 5 of Section I).

If you put your cursor over the three of these
individually, WITHOUT clicking on them, their names
will appear. The top triangle is the First Line Indent.
Directly underneath it, that triangle is the Hanging
Indent. The little rectangle is the Left Indent. Again,
where these three align is the left margin of your
document.

(Just a note, when | say "spaces," | am referring to
hash-marks on the ruler bar.)

3. Setting up Colloquy

Very carefully place cursor over the top triangle, First
Line Indent. Drag it to the right 15 spaces, or an
inch-and-a-half. Now, very carefully grab that bottom
triangle, the Hanging Indent. Move it to the right 5
spaces, or 1/2 inch. Now you can type colloquy
correctly. This set up works well for proceedings
which have no Q and A at all, such as motion for
summary dispositions.

4. Settingup Qand A

The first line in Q and A that you type is, "BY MS.
SMITH:" Again, click on that top triangle on the Ruler
Bar (Fist Line Indent). Move it to the left margin,
zero inches, right where the grey and white meet.
Move the bottom triangle to the position of 1/2 inch, or
half-way between where the grey begins and the "1"
in the white area. You have set up Q and A.

5. Quoted Materials

| suggest typing the whole of your quoted material
first. Then, the portions for which you need to change
the margins, select (highlight) that area with your
mouse. Once your selection is highlighted, use the
triangles on the ruler again to set the first line at 15
spaces and the carry over at 10. Then on the right
side, you will see a lonely arrow, again between the
white and grey area on the ruler bar. Carefully grab
that triangle and move it in five spaces to the left.

6. Parentheticals

Again, type your parenthetical first. Then hit return so
that your current margins are intact when you resume
typing. Place cursor before the open paren. Then
move both the top triangle and bottom triangle in 15
spaces or one-and-a-half inches. | use this method
versus tabs because some programs you input your
document into to generate indexes and
four-pages-to-a-page, DO NOT like tabs. These
programs can rearrange your tabs in your document,
which means it will not meet the standard of transcript
preparation. Further, | find it very cumbersome to tab
carry-over lines continuously throughout a document.

If you have any questions, corrections, and/or
additional information regarding this template
information, please don't hesitate to contact me
at krshankleton@gmail.com or (734) 429-9143.




